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Objective Type Questions

1. Answer these questions:
Ans. 1. Theraw information, which doesn’t make much sense by itself, is called
data.

ii. Hardware devices which are connected with the computer to give data
and instructions as an input to the computer are called input devices, e.g.,
keyboard, mouse, joystick, microphone, etc..

iii. Itis a permanent electronic memory as it does not lose its contents even
after the power supply is switched off. But this memory can only be used
toread from it and we cannot t write anything into it.

2. Tick (v) the correct option:

Ans. 1. d. . a. . a v. ¢ V. ¢
3. Match the following:
Ans. i
1. é;a d.Joystick
ii. *[ r__-‘j c. Outputdevice
a\ RAM
iii. e.
. Py
iv. ‘ b. Cache memory
V. \(3" a. Secondary memory
4. Choose the correct word from the brackets to complete the following
statements:

Ans. 1 Theprocessed form ofdatais called instructions.
ii.  Physical parts of computer are called hard work.
iii. RAMisalso called random access memory
iv. 0'sand 1'sare called bits used to represent data in the memory.
v. Cache memory is used to enhance the CPU performance.

S. Check whether the following statements are True or False:

Ans. 1. True i1.  False . True iv. False v. False
Subjective Type questions

1. Very short answer type questions:

Ans. 1. 1024 bytes il. cache memory

iii. Nibble, Byte, Kilobyte, Megabyte, Gigabyte, Terabyte
iv. Binary Digits
2. Short answer type questions:
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Ans.

il.

111

1v.

V.

There are two major components of computer— Hardware and software
Hardware— Computer hardware are the physical components of the
computer system.

Example—input devices, output devices, storage device etc.
Software—A set of programs is called a software.

Example— System software and application software.

Data— The raw information which does not make much sense by itself. is
called data.

information— The data is processed as per the instructions, to give us the
useful output, is called information.

System software acts like an interface between the use and the computer
to understand user’s problem. example-operating systems.

RAM- Random access memory is temporary memory and the
information is retained in it only as the power supply is on.

ROM- Read only memory is a permanent electronic memory and this
memory can only be used to read from it.

It is high-speed temporary memory where the most recently or most
frequently accessed data is stored.
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= 2. l Programming language

SUMMATIVE ASSESSMENT

Objective Type Questions

1.
Ans.

2.
Ans.
3.
Ans.

Answer these questions:

1.

ii.

iil.

The computer does not understand the languages that we use to
communicative with one-another.

Computer understands the language of binary digits 0 and 1 only. This is
known as machine Language. It is also known as Binary language.
Language Translator are programs that convert programs written in
languages other than Machine Languages to Machine Language, i.c.,
binary codes.

Tick (v) the correct option:

1.

C. . a. ii. a.

Fillin the blanks:

1.
i.
1ii.
1v.
V.
V1.

Language is needed to communicate with the computers.

Machine languages are directly understood by the computer.

Assembly Languages uses letter codes known as Mnemonics.

COBOL Languages is useful for business purposes.

FORTRAN is used for scientific problems.

Compilers and interpretive used for converting High Level Language
programs to machine codes.
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vil. Assemblers are used for converting assembly language programs to

machine codes.
viil. Javais called the Language of Internet.
4. Write the full form of the following acronyms:
Ans. 1. BASIC — Beginner All purpose symbolic Instruction code
i1. COBOL — Common Business oriented Language
iii. FORTRAN - Formula translation
iv. LOGO — Logic Oriented Graphic Oriented
5. Complete the chart showing different Programming Languages:
Ans. :
Programming
v v
Low Level High Level
Language (LLL) Language (HLL)
v v v

Machine .
L Basic Java
anguage

Subjective Type questions

1. Very short answer type questions:
Ans. 1. a. LOGO b. BASIC c. FORTRAN

il. a. Scientific b. Application Software c. Web Designing
2. Short answer type questions:

Ans. 1. Programming language is a language which is used to express a set of
instructions in such a manner that the computer can understand and
follow these instructions. We need these languages to communicate with
computer.

ii. Programming languages are divide into tow major categories:
1. Lowlevel Languages, and
2. HighLevel Languages.

Machine
‘ Languages
Low Level
Languages
f N Assembly
Programming Languages
Languages
k LOGO, BASIC
High Level FORTRAN
Languages PASCAL,

C, C++,
\ COBOL etc.
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1il.

1v.

V.
Vii.

Viii.

Computer understands the language of binary digits 0 and 1 only. This is
known as Machine language Assembly language is a low level language
which uses letter codes instead of binary digits O and 1.

Assembly Language is a low Level Language which uses letter codes
instead of binary digits 0 and 1. These codes are known as Mnemonics.
High Level Language (HLL) use letters, words and mathematical
symbols as used in human languages. They are much faster to learn and
easier to detect and correct errors in HLL program.

Example-Java, c,c,++, pascal etc.

C++has some features of Low Level Languages

Languages Translators are programs that convert programs written in
languages other Machine language to Machine language.

The Translators are classified into three categories

(a) Assemblers (b) compilers (c) Interpreters

An Interpreter is different from a compiler in the sense that it converts the
program step-by-step and not in one single operation.

FORMATIVE ASSESSMENT
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Ans.

Ans.

Ans.

Ans.

Ans.

Doityourself

Tick (v) the correct option:

1.

input . a. . c. v. a V. a.

Very short answer type questions:

1.
ii.

a. LOGO b. BASIC c. FORTRAN
a. Scientific purpose

b. Application software

c. Webdesigning and application software.

Write the full form of the following acronyms:

i. BASIC — Beginner All purpose symbolic Instruction code
ii. COBOL — Common Bussiness oriented Language
iii. FORTRAN - Formulatranslation
iv. LOGO — Logic Oriented Graphic Oriented
Identify the pictures :

L.

CPU ii. Keyboard iii. LCD iv. Mouse v. Joystick

Answer the following questions :

1.

il.

iil.

The raw information, which doesn’t make much sense by itself, is called
data.

Hardware devices which are connected with the computer to give data
and instructions as an input to the computer, are called input devices,
e.g., keyboard, mouse, joystick, microphone, etc.

It is permanent electronic memory as it does not lose its contents even
after the power supply is switched off. But his memory can only be used
toread from it and we cannot write anything into it.
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iv. The computer understand the languages of binary digits 0 and 1 only.

This is known as machine language it is also known as Binary Language.
v. Language Translators are programs that convert programs written in
languages other than Machine Language to Machine Language, i.e.,

binary codes.
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Objective Type Questions

1. Answer these questions:

Ans. 1. An Operating System acts as an intermediate between the user and the
machine. It provides a software platform on which the application
program runs.

ii. Desktop is a part of operating system most of shortcut of application
software and start button is available on it.

iii. An On-Screen keyboard is an important utility program. It displays a
virtual keyboard on the computer screen which allow the user to use the

mouse pointer to type.
2. Tick (v) the correct option:
Ans. 1. a. . a. . b.

3. Fillin the blanks:
Ans. 1. Windows is an operating system that supports the Graphical User
Interface.

ii. An on-screen keyboard is a utility program that displays a virtual
keyboard on the computer screen and allows the user to type using the
mouse pointer.

iii. Mouse icon in the control panel is used for changing the mouse setting
such as button configuration double-click speed.

iv. Regional setting icon of control Panel is used for changing the setting of
the display of languages, numbers, time and date.

v. The Run option form the start button is used for executing a file or

application directly.
4. State whether the following sentences are True or False:
Ans. 1. True ii.  False . True iv. True  v. False
Subjective Type questions
1. Give one word for the following:

Ans. 1. Runoption
ii. On-screen keyboard
1. Desktopicon
iv.  Search option.
v. Regional setting icon.
2. Answer the following questions:
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11.

iil.

1v.

a. Windows operating system supports the Graphical user Interface
(GUI)

b. Working with windows is easy.

c. Search option, Run option, on-screen keyboard and control panel are
advantages of windows.

The run option from the start button is used for executing a file or
application directly.

Search option is present in the start menu. It is mainly used for searching
files and folders stored on the computer disk.

Wildcards ?° “*”are used if the exact name for the file you are searching
isnotknown.

'?' represents one character or space.

"' represents more than one character or space.

We can use control panel to make changes to the look and setting of
windows, including the colour of your desktop, windows, hardware
and software setup and configuration, and security.

FORMATIVE ASSESSMENT

L

s

L
-5 4, l Tables in MS-Word

Doityourself

SUMMATIVE ASSESSMENT

Objective Type Questions

1. Answer these questions:
Ans. 1. The Intersection of row and column form a rectengular block, is called
The call.
ii.  Yes
iii.  Yes
2. Tick (v) the correct option:
Ans. 1. c. . c. . a. v. a. V. a.
3. Match the following:
Ans. 1. Tochangeborder style d. Borderand shading
ii. Toinserttable a. Standardtoolbar
iii.  Row-wise sum c. =Sum(left)
iv.  Column-wise sum b. =Sum (Above)
3. Choose the correct word from the brackets to complete the following
statements:
Ans. 1. Selecting Draw Table option in the Table menu turns the mouse pointer to

ii.

iii.
1v.

pen shape, which can be used for drawing table manually.

Mouse pointer turns to a black downward arrow when it is placed at the
top border of a column

A column can be resized by dragging the edges of a that column.

Auto format option in the table menu is used to apply pre-designed
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formats to the selected table.
v. F9 function key is used to updated the formula result in table

4. State whether the following sentences are True or False:

Ans. 1. False ii.  False . True iv.  True v. False
Subjective Type questions

1. Very short answer type questions:

Ans. 1. Tableoption.

ii. Table Auto format
iii.  Formula option

2. Short answer type questions:

Ans. 1. Atableis formed with the number of rows and columns. Table are used to
present the information in an organized manner. MS word offers different
methods to create tables in a word document. A table can be created using
standard Toolbar, Table menu, and using draw feature creating Table

using standard Toolbar—

Stepl : Keep the cursor at the insertion point where you want to
insert the table.

Step2 : Click Insert table button on the standard toolbar. A grid of
cells will appear with the tool button.

Step3 : Move the mouse pointer diagonally in the grid to select rows
and columns.

ii. Toinsertanew column

Stepl : Select the column in the table, where you want to insert a
new column by clicking at the top border of that column.

Step2 : Select ‘Insert’ option in the ‘Table’ menu. A submenu will
appear.

Step3 :  Select the option ‘Columns to the Left’ or ‘Columns to the

Right’as per your need to get a blank column in the table.
iii. Table autoformat automatically changes the border style, shading, colour
font, style, column width etc. go give a beautiful look on the table.
To apply table auto format feature

Stepl : Clicktable auto formatoption in the ‘Table’ menu.
Step2 : Click any style in the Table style list to see the format in the
preview box.

Step3 :  Finally, click Apply button.
iv.  Yes, Itis possible to perform calculations in a word table. The calculation
are performed either row-wise in last column or column wise in the last

rOw.

To calculate the sum of values row-wise.

Stepl :  Click in the last cell of the row where you want to get the
total.

Step2 : Select ‘formula’ option from the table menu.

Step3 : The formuladialogbox is displayed.

Step4 : Formula to calculate the sum of numerical data to its left is

already displayed in the formula text box as=SUM (LEFT)
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Step5 :  Click OK button to get the sum in the selected cell.

v. Datastored in a table can be arranged in ascending or descending order of
any field in the table. The precess of rearranging the data is called data
sorting.

FORMATIVE ASSESSMENT

Ans.

Ans.

Ans.

Ans.

Ans.

Ans.

Doityourself

Formative Assessment-l|

Tick (v) the correct option:

1. a. ii. b . c. iv. a. V. a.
Give one word for the following:
i. Run

ii. on-screen keyboard
1. Display
iv.  Search option
v. Regionalsettingicon
Match the following:

i.  ToChange border style d. Borderand shading
i1. Toinserttable a. Standard toolbar
iii. Row-wise sun c. =Sum(left)
iv. Column-wise sum b. =Sum (above)
Identify the pictures:
i. Search
ii. Run

iii.  Control panel window
iv. Insert Table dialogue box
v. Theborder and shading dialogue box
Answer the following questions :
i.  Desktop is a part of system software. start button an shortcut of many
application software are located on desktop.

ii. An On-Screen keyboard is an important utility program. It displays a
virtual keyboard on the Computer screen which allows the user to use the
mouse pointer to type.

iii.  Theintersection of column and row form arectengular block, called cell.

iv.  Yes, we can add row or column to our existing table.

v. Yes, we can change the size of rows and columns.

Summative Assessment-|

Fillin the blanks :
i. ROM s apermanent memory.
i1. Assembly language uses letter codes known as Mnemonics.
iii. The Run option from the start button is used for executing a file or

application.
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2.

Ans.

3.

4.

Ans.

S.

Ans.

iv.  Acolumn canberesized by dragging the edges of a that column.
v. F9 function key is used to update the formula result in table.
Werite true of False:
i. True ii.  False . True iv. False v. True
Match the following:
1. Secondary memory
il. Joystick
1il. Outputdevice
iv. Cache memory
V. RAM

Write the full form of the following acronyms :

1.
il.
1ii.
1v.

BASIC —  Beginners All purpose symbolic Instruction code
COBOL —  Common Bussiness oriented Language
FORTRAN —  Formulatranslation

LOGO —  Logic Oriented Graphic Oriented

Answer the following questions :

1.

il.

111

1v.

It is high-speed temporary where the most recently or most frequently
accessed data can be stored to avoid having to reload from a shower
storage medium.

An Interpreter is different from a Compiler in the sense that it converts the
program step-by-step and not in one single operation.

Search option is present in the start menu. It is mainly used for searching
files and folder stored on the computer disk.

Data stored in a table can be arranged in ascending or descending order of
any field in the table. The process of rearranging the data is called Data
sorting.

A table is formed with the number of rows and columns, where a row
intersects a column to form a rectangular block called cell.

A table can be created by using standard Toolbar, table menu an using
draw feature.

To create table using table menu—

Stepl : place the cursor at the insertion point, where table has to be
inserted.

Step2 : Click on Table menu and bring the mouse pointer on the insert
option. The insert submenu will appear.

Step3 : Click Table option in the insert submenu

Step4 : Enter the number of rows and columns in Number of rows
and Number of Column text box respectivity. in ‘insert Table’
dialogue box.

Step5 : ClickOK
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Objective Type Questions
1. Answer the following questions orally:
Ans. 1. Yes,wecanchange the paperorientation.
ii. We can created paragraph by pressing Enter key.
iii. A paragraph indentation is used to emphasize a special paragraph by
providing it with extra spacing from the left or right margins.
2. Tick (3) the correct option:

1. c. . a. . d. iv. b. v. b.
3. Match the following:
Ans. —
i = a. Columns
i. =5 b. PrintPreview
ii. == c. Numbering
. g .
v, LS d. Print
. j e. Switchbetween Header and Footer.
4. Choose the correct word from the brackets to complete the following

statements:
Ans. 1. Intheportraitorientation, page is positioned height-wise.
ii. Paper tab in the page Setup dialog box allows to select a different page

size.
iii. Columns option in the format menu is used to flow the text in more than
one column on a page.
iv. Print preview option in the file menu allows to view the document in a
way it is to printed
v. Document can be directly printed by pressing Print button on the
standard tooth.
5. Check whether the following statements are True or False:
Ans. 1. False it.  True iii.  False iv.  True v. False

5. Arrange the jumble words:
Ans. 1. PRINTER
ii. INDENTATION
iii. LANDSCAPE
Subjective Type questions
1. Very short answer type questions:
Ans. 1. ‘View’menuhasheader and footer optioninit.
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ii.  Yes, we can see the document by print preview option before printing.

iii.  Paper Tab

2. Short answer type questions:

Ans. 1. There are two types of page orientation- portrait and landscape. portrait
orientation means typing the documents height-wise where as Landscape
means the typing documents width-wise.

ii. Paragraph indentation is used to emphasize a special paragraph by
providing it with extra spacing from the left or right margins. We can
indent the paragraph from the left sides right side or from both sides of the
Paragraph.

iii.  We can also use the columns button in the standard toolbar to convert
your text into newsletter style columns, by selecting your text and
dragging the mouse pointer in the grid of columns that appear when you
click columns.

iv. Header and footer are the areas in the top and bottom margins of the page.
We can use these areas to specify some standard information that will
appear at the top or bottom of every page. (Like in a book, name of the
chapter or book name appears at the top and page number appears at the
bottom of every page.)

v.  When we are satisfied with the print preview of our document, we can
print the document like this—

Step1 : Selectthe ‘Print’ option in the ‘File’ menu.

Step2 : Theprintdialogue box is displayed.

Step3 : We can select the printer to be used for printing. age range,
No. of copies, zoom and other options.

Step4 : Click OK

Formative Assessment

Do ityourself
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SUMMATIVE ASSESSMENT

Objective Type Questions
1. Answer the following questions orally:
Ans. 1. Aworksheet, also known as a spreadsheet is the primary document that
youuse in MS Excel to store work and data.
il. The cursor can be moved from cell to cell by using Enter key/Arrow
keys/Mouse click.
iii.  Inlandscape orientation, the page is printed horizontally. When the no. of
columns are larger than rows in a worksheet, we should use landscape

orientation.
2. Tick (v) the correct option:
Ans. 1. a. . a. . a.

3. Fillin the blanks :
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Ans. 1. Microsoft Excelis an electronic spreadsheet software program.
11. InExcel, Column are labelledasA, B, C,...androwsas 1,2, 3,...
1. AAl2isavalid cell label.
iv. To add the values of cells C26 to C28 the formula is +C26+C28 which
can also be written as = C26+C28.
v. Aspreadsheet with labels and formulas filled in for a specific application
is called a worksheet.
vi. The intersection of arow and column in a spreadsheet is called cell.
v. The formula for dividing the value in cell Z1 with the value in cell Al is

+71/A1
4. State whether True or False:
Ans. 1. True 1.  True mi. False iv. False v. True
Subjective Type questions
1. Answer the following questions:

Ans. 1. The intersection of column and row is called cell. label is the name of a
particular cell such as-A1, A2, AA10, etc. The numerical data of a cell is
called cell value. The formula is used for performing Arithmetic
operations like-sum, substraction etc.

i1.  We canreduce the errors in a worksheet by cross check. The formula bar
shows the value and the formula of a cell. To correct the value, select it
and change.

iii. A spreadsheet package is very useful for analysing numerical data. The
numerical value can be easily cross checked and the data can be
represented in pictorial form. The different types of chart can be created
on a worksheet by using data.

iv. The entry can be corrected in a cell by selecting the value in the cell or
formula bar and change it. we can cross check the result and find the error
in the spread sheet.

v. The spreadsheet has a variety of chart. Bar graph, pie chart, column. Line,
XY scatter etc. are different types of chart.

Formative Assessment
Do ityourself
Formative Assessment-Il|
1. Tick (v) the correct option:
Ans. 1. a. . d . a. v. a. V. a.

2. Match the following:

Ans. 1. = c. Numbering
i. B e. Switchbetween Header and Footer.
1il. = a. Columns
1v. _l b. PrintPreview
v. = d. Print
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3. Arrange the jumble words:
Ans. i. PRINTER
ii. INDENTATION
iii. LANDSCAPE
4. Identify the pictures :
Ans. 1. Pagesetup (paper)
ii. Page setup (margin)
iii. chart-wizard
iv. Paragraph (indent and spacing)
v. Pie-chart
5. Answer the following questions :
Ans. 1. Theparagraph canbe created in adocument by using Enter-key
ii. Paragraph indentation is used to emphasize a special paragraph by
providing it with extra spacing from the left or right margins.
We can indent the paragraph form the left side, right side or from both the
sides of the paragraph.
iii. A worksheet, also known as a spreadsheet is the primary document that
you use is MS Excel to store work and data.
iv. The cursor can be moved from one cell to another by pressing Enter-
key/Arrow-keys or by clicking the mouse button.
v. A landscape orientation prints the page horizontally when the no. of
columns are larger than the rows in a worksheet, we should use landscape
orientation.

<N

e il
30 T l Internet (Web Browsing And Chatting) ;;

e jd

SUMMATIVE ASSESSMENT

Objective Type Questions

1. Answer the following questions orally:

Ans. 1. Internetis a network of computers that allows people to get connected to
each other. Getting connected to the Internet allows you to explore the
world oftravel, education science, history and much more.

i1. A modem is an equipment, a part of hardware that enables your computer
to link to the Internet, and send or receive information using your
telephone line.
iii.  Chatting means communicating with people on the Internet. There are
two ways of interacting with people.

2. Tick (v) the correct option:

Ans. 1. a. . a. .  a.

3. Fillin the blanks :

Ans. 1. YouneedamodernandanISP besides acomputer to access internet.

ii.  World Wide Web is a collection of Websites.
iii. 'Web browser allows you to view pages.
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4. Tick (v) True of False:

Ans. 1. True ii.  True 1il.
5. Match the following:
Ans. A
1. @ a.
1.  Website b.
iii. 5 c.
iv. Searchengine d.
6. Solve crossword:
Ans. 1 I
N
T
E
B RO
N
E
SCHAT

Subjective Type questions
1. Answer the following questions:
Ans. 1.

False iv. True v. True

B
Shows active internet connection
Yahoo, Lycos, Altavista, Hotbot
Shows modem at work

A combination of web pages

o v m e oot

Internet is a network of computers that allows people to get connected to

each other. Getting connected to the Internet allows you to explore the
world of travel, education, science, history and much more.
ii. The World Wide Web, commonly known as www or web, is the public

face of internet. The text and images you see on Internet are the part of

web page. Websites are made up of a number of web pages and the world
wide web is the result of all these websites spun by web pages like the

web ofa spider.

iii. A web browser is a software or a program that allows you to view pages,
move around and access the websites.

&
\ 4

(

The two main web browsers are microsoft internet Explorer (IE) and
Mozila Firefox. Both are easy to obtain and free of charge.
iv. Search engines are used to search the websites. We can type keywords or
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categories to search. Most search engines show the result in batches (The

list of sites)

The addresses of some popular search engines are—
<http://www.altavista.com>, <http://www.yahoo.com>,
<http://www.google.com>, <http://www.lycos.com>,

v. Chatting means communicating with people on the internet. There are
two ways of interacting with people.

a. Chat Rooms— We can log into a chat room. In a chat room there is a
list of names and a box for us to type and send our messages in the
room.

b. Chat messenger—A messenger window has every thing in it from adding
a friend’s user name/address in our list, to messaging one and entering a
chartroom too.

FORMATIVE ASSESSMENT

Do ityourself
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SUMMATIVE ASSESSMENT

Objective Type Questions

1. Answer the following questions orally:

Ans. 1. Thisisthe folder where you initially see all the mails that we receive (see
the given figure for reference) To go to Inbox, we can either click on
check mail in the left pane or go to inbox in the right pane.

ii. It is extremely important to sign out because if you don’t sign out them
somebody else might use our account. Therefore, never leave the
computer before signing out.

iii.  Yes, we can send an e-mail in the form of an attachment.

2. Tick (v) the correct option:

Ans. 1. a. ii. b . a.

3. Fillin the blanks:

Ans. 1. Thenew messages thatyoureceive are present in the inbox.

ii. Bulk mail or junkmail is the extra mail that you receive.

ii1.  Draftis the link in your mail account which is used for saving letters that

you compose.
4. Match the following:
Ans. A B
i. & a. Shows active internet connection
i1. d. Carbon copy of amail
1il. c. Shows modem at work
1v. b. Yahoo, Lycos, Altavista, Hotbot
v. CC d. Acombination of web pages
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4.
Ans.

Tick (v) True or False:

L.

False ii.  False mi. False iv. False

Subjective Type questions

1.
Ans.

Answer the following questions:

1.

ii.

1il.

1v.

Contact mail. commonly called E-mail, is another feature of internet
used to keep in touch with people from distant lands. A message can reach
a computer on the other side of the world minutes at the cost of a local
telephone call.

The electronic mail will work only when:

a. Youhave active internet connection. You need to be working online
to send an E-mail.

b. You need to have an e-mail account (address) for people to receive
your mail at one particular address or send mails from that address.

To send an-emai. we need a valid e-mail account. The e-mail can be sent

by following steps—

Stepl : Gotocompose Folder

Step2 : Typeemail account address of the receiver in the To box.

Step3 : Writeyour letter an subject.

Step4 : You can attach a file or letter with your e-mail by using
Attach option.

Step5 : Clicksend,

Sign in: The e-mail address and pass word are provided by the mail sites.
To sign in, we need to fill in our username and password then click on
signin.

Check e-mail: e-mails are checked by inbox folder. To check the
received mail, First sign in the accout and go to inbox/check mail folder.
Sign out: click on sign out from the left pane or on the top of the page
‘CC’means carbon copy and ‘BCC’ means Blank carbon copy. CC box is
used for sending the same mail to any other person. BCC box is used for

sending the same mail to any other person but not to be seen by the person
inthe To and ‘CC’ box.

FORMATIVE ASSESSMENT
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9. l Introduction to QBasic

Do ityourself

SUMMATIVE ASSESSMENT

Objective Type Questions

1.
Ans.
2.
Ans.

Tick (v) the correct option:

1.

d. il. a m. b v. a. v. b.

Check whether the following statements True or False:

1.

False ii.  False 1.  True iv. True v. True
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3. Choose the correct word from the brackets to complete following
statements:
Ans. 1. Keywordshave aspecific meaning in that language.
ii. The cls command clears the output screen.
iii. Aprogram canbe executed FSkey.
iv. Programin QBASIC s save with BAS extension.
v. LET statement asks to enter value for the variable.
4. Match the following:

Ans. 1. Grammatical a. QBASIC
ii. Pro grar@ib. Commands
1. Orders c. Syntax
iv. § d. Assignment
v. Let e. String Variable
Subjective Type questions
1. Very short answer type questions:

Ans. 1. QBASIC- Quick Beginners all purpose symbolic instruction code.
ii. There are two types of variables—Integer variables and string variables
iii.  Click RUN in the menu bar and choose START option in it or press the F5
function key.
2. SHORT ANSWER TYPE QUESTIONS:
Ans. 1. a. All the statements in a QBASIC program should appear in a proper
sequence.
b. Each statement should appear in a separate line.
c. [Eachstatement should have akeyword init.
d. Syntaxrules should be strictly followed.
ii. LET is an assignment which allows us to store or assign value to a
variable.
Syntax: LET <variable name> = Expression or constant PRINT
keyword is used to write something on the screen.
Syntax: PRINT <Messages
iii. a. Variable name always starts with an alphabet.
b. Isshouldnotbea QBASIC keyword.
c. Itshouldnothaveaspaceinit.
d. Special characters except $, %, &, # are not allowed.
FormATiVE ASSESSMENT

Do ityourself
Formative Assessment-1V
1. Tick (v) the correct option:
Ans. 1. a. . a. 1. a. v. b. V. a.
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2. Match the following:

Ans. A B
i. & a. Shows active internet connection
1.  Website b. Yahoo, Lycos, Altavista, Hotbot
. B c. Showsmodem at work
iv. Searchengine d. Acombination of web pages
3. How would you:
Ans. 1. Fillinuser name and password then sign in.

ii.
iil.

Go to inbox.
Sign out at left pane or top of page

4. Identify the pictures:

Ans. 1. Mozila fire fox
ii. Back
1. Refresh
iv. Internet Explorer
v. History of Web sites.

5. Answer the following questions :

Ans. 1. Amodem isanequipment, a part of hardware that enables your computer
to link to the Internet, and send or receive information using your
telephone line.

ii. Chatting means communicating with people on the internet. There are
tow ways of interacting with people.

iii.  This is the folder where you initially see all the mails that we receive (see
the given figure for reference). To go to inbox, we can either click on
check mail in the left pane or go to inbox in the right pane.

iv. It is extremely important to sign out because if you don’t sign out then
somebody else might use our account. Therefore, never leave the
computer before signing out.

v. Yes, we can send an e-mail in th form of an attachment.

Summative Assessment-I|

1. Fillin the blanks :

Ans. 1. Intheportraitorientation, page is positioned height wise.
ii. 'Web browser allows you do view pages.
1. Microsoft Excel is an electronic spread sheet software program.
iv. Thenew messages that youreceive are present in th Inbox.
v. Bulkmail or Junkmail is the extra mail that you receive.
2. Write true of False:
Ans. 1. False i.  True iii.  False iv. False v. False
Ans. B
1. a. Shows active internet connection
1. b. Yahoo, Lycos, Altavista, Hotbot
1il. ¢. Shows modem at work
1v. d. Acombination of web pages
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4. Label the following window:

Ans.
@ -
5. Answer the following questions :
Ans. 1. Toprintadocumentin MS-Word—
Step 1 : Click file menu.
Step 2 : Choose print option from drop-down list.
Step 3 : We can change print orientation, page range zoom
and other options as per needed.
Step 4 : Click OK, the pages will be printed.

11.
iil.

1v.

V.

First select the value in the cell or formula bar then change it.

Chatting means communicating with people on the internet. There are
two ways of interacting with people-chat rooms and messenger.

A web browser is a software or program that allows you to view pages,
move around and access the websites.

£

The two main web browsers are microsoft internet Explorer (IE) and

Mozila Firefox. Both are easy to obtain and free of charge.

The electronic mail will work only when:

a. Youhave active internet connection. You need to be working online
to send an E-mail.

b. You need to have an e-mail account (address) for people to receive
your mail at one particular address or send mails from that address.
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